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spreadsheet 

 

A type of application program which 

manipulates numerical and string data in 

rows and columns of cells.  

The value in a cell can be calculated from a 

formula which can involve other cells. 

 A value is recalculated automatically 

whenever a value on which it depends 

changes. 

 Different cells may be displayed with 

different formats. 
 

 

 



SPREADSHEET 

• Spreadsheet is a large sheet of paper with 
rows and columns and is used to record 
business transactions. 

• An electronic spreadsheet organises 
information into software defined rows and 
columns. 

• The data can then be added up by a formula 
to give a total or sum. 



ADVANTAGES OF ELECTRONIC 
SPREADSHEET 

• 1. Very much useful in business. 
• 2. Can be used for accounting, sales, inventory control 

and financial analysis. 
• 3. Also used for many other non business problems. 
• 4. In addition to routine jobs, they are also used for 

financial analysis and forecasting. 
• 5. Long term strategy to be used by a business concern 

can easily be determined with the help of 
spreadsheets. 

• 6. They are useful to provide guidance to the investors 
to select and invest in most profitable securities. 



Workbook  

1.  A booklet containing problems and exercises that 

a student may work directly on the pages.  

2. A manual containing operating instructions, as for 

an appliance or machine.  

3. A book in which a record is kept of work proposed 

or accomplished.  

Worksheet 

1.  A sheet of paper with multiple columns; used by 

an accountant to assemble figures for financial 

statements. 

2.  A piece of paper recording work planned or done 

on a project. 
 
 



The Basics 

Open Excel. 

By default, Excel will open a blank 

workbook that contains three worksheets 

(spreadsheets).  Each box, located in both 

a column and a row, is called a cell. 



FILE TAB 

• The file tab replaces the Office button from 
Excel 2007. 

• We can click it to check Backstage view, which 
is the place to come when we want to open or 
save files, create new spreadsheets, print a 
sheet and to do other file related operations. 



The Title Bar is located at the very top of the screen. On the Title bar, Microsoft 

Excel displays the name of the workbook you are currently using. At the top of 

your screen, you should see "Microsoft Excel - Book1" or a similar name.  

The Menu Bar is directly below the Title bar and displays the menu. The menu 

begins with the word File and continues with the following: Edit, View, Insert, 

Format, Tools, Data, Window, and Help. You use the menu to give instructions 

to the software. Point with your mouse to a menu option and click the left mouse 

button. A drop-down menu will appear. You can now use the left and right arrow 

keys on your keyboard to move left and right across the Menu bar options. You 

can use the up and down arrow keys to move up and down the drop-down 

menu. To select an option, highlight the item on the drop-down menu and press 

Enter.  



Toolbars  



Microsoft Excel consists of worksheets. Each worksheet contains columns 

and rows. The columns are lettered A to IV; the rows are numbered 1 to 

65536. The combination of column and row coordinates make up a 

cell address. For example, the cell located in the upper left corner of the 

worksheet is cell A1, meaning column A, row 1. Cell E10 is located under 

column E on row 10. You enter your data into the cells on the worksheet.  



QUICK ACCESS TOOLBAR 

• It is located above the ribbon and is useful to 
access the commands that are frequently 
used. 

• By default it shows Save, Undo and Repeat 
commands and we can add other commands 
also. 



THE RIBBON 

• It is used to issue commands . 

• It is located near the top of the Excel window, 
below the Quick Access Toolbar. 

• Ribbon contains commands organized in three 
components. 

• A) Tabs 

• B) Groups 

• C) Commands 



COMPONENTS IN RIBBON 

• Tabs: They appear across the top of the Ribbon 
and contain groups of related commands. Home, 
Insert, Page Layout are examples of ribbon tabs. 

• Groups: They organise related commands, each 
group name appears below the group on the 
Ribbon. Eg: Group of commands related to fonts, 
alignments etc. 

• Commands: Commands appear within each 
group as mentioned above.  



TITLE BAR 

• This lies in the middle and at the top of the 
window. 

• It shows the program and the sheet titles. 



HELP 

• This icon helps to provide nice tutorial on 
various subjects related to excel. 



Excel Help 



ZOOM CONTROL 

• It helps to  in for a closer look at your text. 

• The zoom control consists of a slider that can 
slide left or right to zoom  and + button helps 
to increase he zoom factor. 



VIEW BUTTONS 

• The group of three buttons located to the left of 
the Zoom control, near the bottom of the screen, 
lets you switch among excel’s various sheet 
views.  

• 1. Normal Layout view: This displays page in 
normal view. 

• 2. Page Layout view: This displays pages exactly 
as they will appear when printed. This gives a full 
screen look of the document. 

• 3. Page Break view: This shows a preview of 
where pages will break when printed.  



SHEET AREA 

• The area where you enter data. 

• The flashing vertical bar is called the insertion 
point and it represents the location where text 
will appear when you type. 



ROW BAR 

• Rows are numbered from 1 onwards and 
keeps on increasing as you keep on entering 
data. 

• Maximum limit is 1,048,576 rows. 



COLUMN BAR 

• Columns are numbered from A onwards and 
keeps on increasing as you enter data. 

• After Z, it will start AA,AB and so on. 
Maximum limit is 16,384 columns. 

 



STATUS BAR 

• This displays sheet information as well as the 
insertion point location. 

• From left to right, this bar contains the total 
number of pages and words in the document, 
language etc. 



CUSTOMISE THE RIBBON 

• We can customise the ribbon by creating our own 
tabs. 

• 1. Right click the ribbon., then select customise 
the ribbon. A dialog box will appear.  

• 2. Click a new tab. 

• 3. Make sure the new group is selected. 

• 4. Select a command from list on left , then click 
ADD. 

• 5. Click OK. 



MINIMISE AND MAXIMISE THE 
RIBBON 

• 1. Click the arrow in the upper-right corner of 
the ribbon to minimise it. 

• 2. To maximise the ribbon, click the arrow 
again.  



Backstage view 

• It is introduced in Excel 2010 and acts as a 
central place for managing worksheets. 

• It helps in creating new sheets, saving and 
opening sheets, printing and sharing sheets 
and so on. 

• To access it, just click File tab located in upper 
left corner of the ribbon. 



RANGES IN MS EXCEL 

• A cell is a single element in a worksheet where 
we can enter a value, text or formula and is 
identified by address, with column letter and 
row number. 

• A group of cells is called a range. 

• Ranges can have range address by specifying 
the upper left cell address and its lower right 
cell address, separated by a colon. Eg: A1:E4.  



SELECTING RANGES 

• 1. Press the left mouse button and drag, 
highlighting the range. Then release mouse 
button. 

• 2. Press the Shift key while you use the navigation 
key to select the range. 

• 3. Press F8 and then move the cell pointer with 
the navigation keys to highlight the range. Press 
F8 again to return to normal movement. 

• 4. Type the cell or range address into the Name 
box and Press enter. 



SELECTING COMPELETE ROWS AND 
COLUMNS 

• 1. To specify multiple adjacent rows or 
columns, click a row or column border and 
drag to highlight additional rows or columns. 

• 2. To select multiple non-adjacent rows or 
columns, press Ctrl while you click the row or 
column borders that you want.  



AUTO FILL 

• It is a unique feature of MS Excel. 

• It has the ability to fill out some cells with 
values that belong to a common series. 

• First select a cell or the cells that define the 
series. 

• Position our mouse on the lower right corner 
of the selected cell or cells, and then drag in 
appropriate direction.  

 



MOVING WITH THE KEY BOARD 

• Keystroke     Where the insertion point  moves 
• Right arrow            Forward one box 
• Left arrow              Back one box 
• Up arrow                Up one box 
• Down arrow          Down one box 
• Page up                  To previous screen 
• Page down             To next screen 
• Home                      beginning of the current screen 
• End                          end of the current screen         



GO TO COMMAND 

Press F5 and it will display the dialog box where 
you can get options to reach a particular box.  



SAVING A WORKBOOK 

• 1. Click the File tab and select Save As option. 

• 2. Select where you want to save file. Enter file 
name and select save as type. 

• 3. Click save 

 



SAVING NEW CHANGES 

• 1. Press Ctrl+ S 

• 2. Click floppy icon on left corner. 

• 3. Click save option available above save as. 



CREATING NEW WORKSHEETS 

• 1. Right click the Sheet name and select Insert 
option. 

• 2. We can see the Insert dialog with select 
Worksheet option. Click ok. 

• 3. Now a new blank sheet will come 

• Short Cut to create new sheet is clicking 
Shift+F11 key.  



COPY WHOLE SHEET 

• 1. Right click on the sheet name at bottom. 
Move or copy dilaog box will appear and 
select Worksheet option. Click Ok. 

• 2. Select Create a Copy to create a copy of 
current sheet. 

• 3. Press OK. 



HIDING AND UNHIDING WORKSHEET 

• 1. Right click the Sheet Name and select Hide 
option. The sheet will disappear 

• 2. Right click on any sheet and select Unhide 
option.  



DEELTING WORKSHEET 

• To delete a workbook, right click its tab and 
click Delete.  



CLOSE WORKBOOK 

• 1. Click the Close button on the top. We will 
get a confirmation message to save the 
Workbook. 

• 2. Press Save button to save the workbook. 



OPEN WORKBOOK 

• Click File menu. 

• We can see Recent workbook and Recent 
Places. 

• Select appropriate workbook and click Open.  



INSERTING DATA 

• Just activate the cell by Pressing F5 and 
entering required cell number. 

• Press the text, numeric value or formulas.   



MODIFYING CELL CONETENT 

• Editing consists of deleting, replacing, altering 
or adjusting something in them. 

• To make a cell in edit mode either double click 
on the cell or Press F2 and do the required 
alterations in the cell content.  



Delete data 

• Select data to be deleted . Right click. Select 
delete option. 

                                        OR 

Select data to be deleted. Press Delete button 
on key board.  



MOVE DATA (CUT AND PASTE) 

• Select data to be moved. Right click and select 
CUT . 

• Select the first cell where you want to move 
data. Right click and  opt Paste. 

                                            OR 

• Select data. Click Control+ C to Copy  

• And Click Control+ V to paste. 



FIND AND REPLACE 

• Select Home. 

• Click Find and Select on upper right side. 

• Click Find or Press Control+ F. 

• You will find the Find and Replace dialog box. 
Type the text you want to find. 

• You can replace the text with new text with 
Replace tab.  



SPELL CHECK 

• Choose Review 

• Select Spelling or press F7. 

• If the spell checker finds any words it does not 
recognise as correct, it displays Spelling dialog 
with suggested options. 



SYMBOLS 

• Go to Insert  

• Click Symbols. 

• Select appropriate symbol. 



SPECIAL CHARACTERS 

• Go to Insert. 

• Press Symbols. 

• Select Special Characters 

• Chose desired one. 



TEXT BOXES 

• They are special graphic objects that combine 
text with a rectangular graphic object. 

• Click Insert. 

• Click Text Box. 

• Choose text box or draw it.  



FORMATTING TEXT BOX 

• After you added text box, you can format it by 
changing the font, font size, font style , 
alignment etc. 



UNDO CHANGES 

• From Quick Access tool bar click Undo  

                                      OR 

• Press Control+ Z.  



REDO CHANGES 

• From Quick Access tool bar click Redo  

                                      OR 

• Press Control+ Y.  

 



CELL FORMATTING 

• Right click on Cell. 

• Choose Format cells. 

• Do required formatting. 



FONTS 

• Go to home. 

• Select Font Group. 

• Select the font.  



BOLD, ITALICIZE AND UNDERLINE 

• Bold: It makes text highlight by choosing Home>> 
Front Group >> Click B or Press Control +B . 

• Italic: Choose Home>> Font Group >> Click I or 
press Control + I. 

• Underline: Choose Home >> Font Group >> Click 
U or press Control + U . 

• Double underline: Choose Home>> Font 
Group>>Click arrow near U>> Select Double 
Underline.  



ROTATING CELL 

• Click on  Orientation in the Home tab. 

• Choose available options like Angle Counter 
Clockwise, Angle Clockwise etc. 

•                                 OR 
Right click on cell. Choose Format Cells>> 
Alignment>> Set the degree for rotation.  



CHANGING BACKGROUND COLOUR 

• Home Tab >> Font Group >> Background 
colour. 



CHANGING FOREGROUND COLOUR 

• Home tab >> Font Group >> Foreground 
colour 

 

                                            OR 

• Right click>> Format cells >> Font Tab >> 
Colour. 



CELL CONTENT ALIGNMENT 

• By default, numbers will be shown on right 
side of the cell and text will be shown on the 
left side of the cell.  

• We can change alignment , by choosing some 
options.   



HORIZONTAL ALIGNEMENT 

• We can set horizontal alignment to the Left, 
Centre, Right etc.  

• Left : Aligns the cell contents to the left side of 
the cell. 

• Center : Centres the cell contents in the cell. 

• Right: Aligns the cell contents to the right side 
of the cell. 



VERTICAL ALIGNMENT 

• You can set Vertical alignment to top, Middle, 
bottom etc. 

• Top: Aligns the cell content to the top of the 
cell. 

• Center: Centres the cell contents vertically in 
the cell. 

• Bottom: Aligns the cell contents to the bottom 
of the cell. 

 



MERGE CELLS 

• Ms Excel enables to merge two or more cells. 

• When we merge cells, we cannot combine the 
contents of cells. 

• We are actually combining a group of cells 
into a single cell that occupies the same space.   

• To merge cells, select the cells that you want 
to merge and then click the Merge & Center 
button.  



MERGE CELLS 

• Choose Alignment tab of the Format Cells dialog 
box to merge cells. 

• The Home>> Alignment group>> Merge & Centre 
control contains a drop-down list with these 
additional options: 

•   1. Merge Across- when a multi-row range is 
selected, this command creates multiple merged 
cells- one for each row. 

•    2. Merge cells- Merges the selected cells 
without applying the Center attribute. 

•    3. Unmerge cells- Unmerges the selected cells.  



WRAP TEXT AND SHRINK TO FIT 

• If you have text too wide to fit the column 
width but don’t want that text to spill over 
into adjacent cells, you can either Wrap Text 
option or the Shrink to Fit option to 
accommodate that text.  



BORDERS AND SHADES 

• We can press the down arrow next to the 
Border button, a menu appears. 

• By making proper selection from the menu, 
we can place a border on the top, bottom, left 
or right side of the selected cells; on all sides; 
or around the outside border.  

• We can also have a thick outside border or a 
border with a single-line top and a double-line 
bottom.  



APPLY BORDERS 

• To apply border select the range of cells Right 
Click >> Format Cells >> Border Tab >> Select 
the Border style. 

• Then you can apply border by Home Tab >> 
Font Group >> Apply borders. 



APPLYING SHADING 

• Home tab >> Font Group >> Select the colour. 



FORMATTING CELLS 

• In MS Excel you can apply formatting to the 
cell or range of cells by Right Click >> Format 
cells >> Select the tab. 

• Various tabs are available. Choose the tab as 
per our need. 

 



MARGINS 

Choose Page Layout >> page Setup >> margins 
drop-down list , you can select Normal, Wide, 
Narrow or the custom setting.  



PAGE ORIENTATION 

• It refers to how output is printed on page. If you 
change the orientation, the onscreen page break 
adjust automatically to accommodate new paper 
orientation. 

• Types of page orientation 
• Portrait 
• Landscape 
• Changing Page Orientation 
• Page Layout >> Page Setup >> Orientation >> 

Portrait or Landscape. 



HEADER AND FOOTER 

• A header is information that appears at the 
top of the page and footer is that appears on 
the bottom of the page. 

• To insert it 

• Choose Page Setup dialog box>> Header or 
Footer tab.  



PAGE BREAKS 

• If you don’t want a row to print on a page by 
itself or you don’t want a table header row to 
be the last line on a page.  

• Inserting Page Breaks 

• To insert horizontal page break for ex , if you 
want row 14 to be the first row of a new page, 
select cell A14. Then choose 

• Page Layout>> Page Setup Group >> Breaks >> 
Insert page Break. 



REMOVING PAGE BREAKS 

Move the cell pointer to the first row beneath of 
the manual page break and then choose  

Page Layout >> Page Setup >> Breaks  >> 
Remove Page Break. 

 



FREEZING PANES 

• In the case of long worksgeet with row or 
column headings, these headings will not be 
visible when we scroll down or to the right.  

• Freezing panes keeps the headings visible 
while scrolling through the work sheet.  



USING FREEZE PANES 

• Select the First row or First column or row below 
which you want to freeze or Column right to the 
area which you want to freeze. 

• Choose View Tab>> Freeze Panes. 
• Select suitable option 
•         Freeze panes : To freeze area of cells 
•         Freeze top row : To freeze first row of the 

worksheet 
•         Freeze First Column : To freeze first column 

of the worksheet.  



UNFREEZE PANES 

• Choose View tab >> Unfreeze panes .  



SORTING 

• We can sort data by text A to Z or Z to A, numbers 
( smallest to largest or largerst to smallest) and 
dates and times ( oldest to news and newest to 
oldest ) in one or more columns.  

• 1. Sorting in ascending order – A to Z. 

• 2. Sorting in descending order – Z to A. 

• 3. Custom sort- includes sorting by the cell 
background colour or the font colour of the data.  



FILTERING 

• Display only the rows that met certain conditions.  
• Click the column or columns  the data to be filtered. 
• On the Home tab, click Sort& Filter. 
• Click Filter button. 
• Click the Arrow at the bottom of the first cell. 
• Click the Text Filter. 
• Click the words you want to filter. 
•                                     &  
• To clear the filter click the Sort & Filter button. 
• Click Clear.   

 
 



FORMULAS IN EXCEL 

• Formulas are mathematical equations. 

• The use and implementation of a function 
always starts with an equal sign “=” followed 
by the name of function. 



Use AutoSum to sum numbers 
 

• If you need to sum a column or row of 
numbers, let Excel do the math for you. Select 
a cell next to the numbers you want to sum, 
click AutoSum on theHome tab, press Enter, 
and you’re done.  

• When you click AutoSum, Excel automatically 
enters a formula (that uses the SUM function) 
to sum the numbers. 

 



FORMATTING NUMBERS 

• We can format the numbers entered in cells. 

• We can add commands to separate 
thousands, specify the of number decimal 
places, place a dollar sign in front of the 
number, or display the number as present etc. 



FUNCTIONS 

• The prewritten formulas in MS Excel are called 
functions. 

• They differ from regular formulas in that we 
supply the value but not the operators, such as, 
+, -, * or /.  

• The equal sign begins the function. 
• The values inside the parantheses are called 

arguments.  
• Parantheses enclose the arguments. 
• A comma separates the arguments. 



SUM FUNCTION 

• It is used to add the contents of various cells. 

• The syntax is SUM(first value, second value 
etc). 

 



PRODUCT FUNCTION 

• It calculates the product (multiplication) of a 
supplied set of numerical values. 

• The syntaz function is PRODUCT(number 1, 
[number 2], ……..) 



SQRT FUNCTION 

• It calculates the positive square root of the 
number. 

• The syntax function is: SQRT(number). 



ROMAN 

• The excel roman function converts an Arabic 
number to Roman. 

• The format of the function is (number,[form]) 

• Number- The number that is to be converted 
to a Roman numeral must be an integer 
between 0 and 1999. 

• Form- An optional argument that specifies the 
form of the Roman numeral returned. 



ROUND 

• The Excel Round function rounds a supplied 
number up or down, to a specified number of 
decimal places. 

• The syntax of the function is : 
ROUND(NUMBER,num_digits) 

  



AVERAGE 

• The AVERAGE function displays the average or 
mean value of selected cells.  

• The syntax form is AVERAGE(number1, 
number2, …………………….) 



MEDIAN 

• It is used to calculate the median of given 
numbers. 

• It is the number in the middle of a set of 
numbers, that is, half the numbers have 
values that are greater than the median, and 
half the values are lower than the median. 



AVEDEV function 
 

• Description 

• Returns the average of the absolute deviations 
of data points from their mean. AVEDEV is a 
measure of the variability in a data set. 

• Syntax 

• AVEDEV(number1, [number2], ...) 

 



CORREL function 
 

• Description 
• Returns the correlation coefficient of the Array1 and Array2 

cell ranges. Use the correlation coefficient to determine the 
relationship between two properties. For example, you can 
examine the relationship between a location's average 
temperature and the use of air conditioners. 

• Syntax 
• CORREL(array1, array2) 
• The CORREL function syntax has the following arguments: 
• Array1    Required. A cell range of values. 
• Array2    Required. A second cell range of values. 

 



MODE 

• A statistical term that refers to the most 
frequently occurring number found in a set of 
numbers.  

• The mode is found by collecting and 
organizing the data in order to count the 
frequency of each result. 



MODE 

• MODE function 

• Returns the most frequently occurring, or 
repetitive, value in an array or range of data.  

• Syntax 

• MODE(number1,[number2],...) 

 



MODE 

• The Excel MODE function returns the 
statistical mode (the most frequently 
occurring value) of a list of supplied numbers. 
The format of the function is: 

• MODE( number1, [number2], ... ) 

• where the number arguments are a set of one 
or more numeric values, or arrays of numeric 
values, for which you want to calculate the 
mode. 

 



MODE.SNGL function 

• The Excel MODE.SNGL function returns the 
statistical mode (the most frequently occurring 
value) within a list of supplied numbers. If there 
are 2 or more most frequently occurring values in 
the supplied data, the function returns the lowest 
of these values. 

• The format of the Mode.Sngl function is 
    MODE.SNGL( number1, [number2], ... ) 
• where the number arguments are up to 255 

numeric values, or arrays of numeric values, for 
which you want to calculate the mode. 
 



MODE.SNGL & MODE.MULT Functions 
 

• The MODE.SNGL and the MODE.MULT functions 
both find the statistical mode (the most 
commonly occurring value (or values) of a 
supplied set of numbers). 

• The difference between the functions occurs 
when the supplied data set has more than one 
mode. The Mode.Sngl function returns the lowest 
of these values, whereas the Mode.Mult function 
returns an array of all of the modes. 



FORECAST 

• The Excel Forecast function predicts a future point on a 
linear trend line fitted to  supplied set of x and y values. 

• The syntax function is  
• FORECAST(x, known_y’s,known_x’s) 
• Where x- a numeric value for which you want to forecast a 

new y-value. 
• Known_y’s – an array of known y-values. 
• Known_x’s- an array of known x-values. 
• The length of the known _x’s arrays should be the same as 

known y’s and the variance of the known_x’s must not be 
zero. 



FINANCIAL FUNCTIONS 

• These functions have been provided to 
perform many of the commonly used financial 
calculations, such as the calculation of yield, 
interest rates, investment valuations, internal 
rate of return, payment and assets 
depreciation.  



FUTURE VALUE FUNCTION 

• The Excel FV function calculates the Future Value of an investment 
with periodic constant payments and a constant interest rate. 

• The syntax of the function is: 
• FV( rate, nper, [pmt], [pv], [type] ) 
• Rate- the interest rate per period 
• nper- the number of periods for the lifetime of the annuity. 
• [pmt]- an optional argument that specifies the payment per period . 

If [pmt] argument is omitted, the [pv] argument must be supplied. 
• [pv]- an optional argument that specifies the present value of 

annuity, ie, the amount that a series of future payments is worth 
now. 

• [type]- an optional argument that defines whether the payment is 
made at the start or end of the period.  



PV FUNCTION 

• PV calculates the present value of investment. 

• The present value is the total amount that a 
series of future payments is worth now. 

• The syntax form is PV(rate,nper,pmt,fv,type) 

• Where pmt- an optional argument that 
specifies the payment per period.  



NET PRESENT VALUE 

• The difference between the present value of the future 
cash flows from an investment and the amount of 
investment. Present value of the expected cash flows is 
computed by discounting them at the required rate of 
return. 

   

• A zero net present value means the project repays 
original investment plus the required rate of return. A 
positive net present value means a better return, and a 
negative net present value means a worse return, than 
the return from zero net present value. 

 



NET PRESENT VALUE 

• First, enter the anticipated discount rate into cell A1. Next, input all 
cash flows sequentially into adjacent cells, entering any outflow 
values as negative numbers. For example, a project with a single 
initial investment that is expected to generate returns over the 
course of three years will have four entries in cells A2 through A5. 
Excel assumes all flows occur at the end of each period. Therefore, 
if the initial investment occurs at project inception rather than at 
the end of the first period, then this figure will need to be added to 
the NPV function separately and not included in the function itself. 

• If the initial investment occurs at the end of the first period, as the 
program assumes, enter the formula "=NPV(A1,A2,A3,A4,A5)" into 
cell A6 to render the NPV for this project. 
 



Internal Rate of Return (IRR) 

 
• Internal rate of return (IRR) calculates the internal rate 

of return for a series of cash flows. 
• It is the interest received for an investment consisting 

of payments(negative values) and income (Positive 
values) that occur at regular periods. 

• Internal rate of return is used to evaluate the 
attractiveness of a project or investment. If the IRR of a 
new project exceeds a company’s required rate of 
return, that project is desirable. If IRR falls below the 
required rate of return, the project should be rejected. 

• Syntax is IRR(values,guess) 
 



PMT FUNCTION 

• The Excel PMT function calculates the constant periodic payment 
required to pay off (or partially pay off) a loan or investment, with a 
constant interest rate, over a specified period. 

• The syntax of the function is: 
• PMT( rate, nper, pv, [fv], [type] ) 
• Rate- interest rate per period 
• nper- total amount of payment periods in an annuity 
• Pv- present value the total amount that a series of future payments 

is worth now. 
• Fv- future value, or a cash balance we want to attain after the last 

payment is made. If fv is omitted, it is assumed to be zero. 
• Type is the number 0 or 1 and indicates when payments are due.  

 



IPMT function 

• The Excel IPMT function calculates the interest 
payment, during a specific period of a loan or 
investment that is paid in constant periodic 
payments, with a constant interest rate. 

• The syntax of the function is: 

• IPMT( rate, per, nper, pv, [fv], [type] ) 

 



IPMT function 

• Rate    Required. The interest rate per period. 
• Per    Required. The period for which you want to find the 

interest and must be in the range 1 to nper. 
• Nper    Required. The total number of payment periods in 

an annuity. 
• Pv    Required. The present value, or the lump-sum amount 

that a series of future payments is worth right now. 
• Fv    Optional. The future value, or a cash balance you want 

to attain after the last payment is made. If fv is omitted, it is 
assumed to be 0 (the future value of a loan, for example, is 
0). 

• Type    Optional. The number 0 or 1 and indicates when 
payments are due. If type is omitted, it is assumed to be 0. 
 



NPER FUNCTION 

• The Excel NPER function calculates the number of periods required to pay 
off a loan, for a constant periodic payment and a constant interest rate. 

• The syntax of the function is: 
• NPER( rate, pmt, pv, [fv], [type] ) 
• Rate    Required. The interest rate per period. 
• Pmt    Required. The payment made each period; it cannot change over 

the life of the annuity. Typically, pmt contains principal and interest but no 
other fees or taxes. 

• Pv    Required. The present value, or the lump-sum amount that a series of 
future payments is worth right now. 

• Fv    Optional. The future value, or a cash balance you want to attain after 
the last payment is made. If fv is omitted, it is assumed to be 0 (the future 
value of a loan, for example, is 0). 

• Type    Optional. The number 0 or 1 and indicates when payments are due. 
 
 



DB FUNCTION 

• The Excel DB function calculates the depreciation of an asset, using the 
Fixed Declining Balance Method, for each period of the asset's lifetime. 

• The format of the function is: 
• DB( cost, salvage, life, period, [month] ) 
• cost The original cost of the asset. 
•  salvage The salvage value after the asset has been fully depreciated.  
• life The useful life of the asset or the number of periods that you will be 

depreciating the asset. 
•  period The period that you wish to calculate the depreciation for. Use the 

same units as for the life. 
•  number_months Optional. It is the number of months in the first year of 

depreciation. If this parameter is omitted, the DB function will assume 
that there are 12 months in the first year.  



SLN FUNCTION 

• The Excel SLN function calculates the straight line 
depreciation of an asset for one period. 

• Syntax 
• SLN(cost, salvage, life) 
• The SLN function syntax has the following arguments: 
• Cost    Required. The initial cost of the asset. 
• Salvage    Required. The value at the end of the 

depreciation (sometimes called the salvage value of the 
asset). 

• Life    Required. The number of periods over which the 
asset is depreciated (sometimes called the useful life of the 
asset). 
 



SYD function 

• The Excel SYD function calculates the sum-of-years' digits 
depreciation for a specified period in the lifetime of an asset. 

• The format of the function is: 
• SYD( cost, salvage, life, per ) 

 
• Cost    Required. The initial cost of the asset. 
• Salvage    Required. The value at the end of the depreciation 

(sometimes called the salvage value of the asset). 
• Life    Required. The number of periods over which the asset is 

depreciated (sometimes called the useful life of the asset). 
• Per    Required. The period and must use the same units as life. 

 



How to Record a Macro to Automate 
Tasks in Excel 2010 

 
• You can use macros in Excel 2010 to save time by 

automating tasks that you perform frequently.  
• A macro is a series of commands grouped together that you 

can run whenever you need to perform the task. 
• When you record a macro, Excel stores information about 

each step you take as you perform a series of commands. 
You then run the macro to repeat, or play back, the 
commands. 

• The macro recorder records every action you complete. 
Therefore, planning your macro before you begin the 
recording process is very important so you don't record 
unnecessary steps. 
 



Record a macro 
 

• Follow these steps to record a macro: 
1. Choose Record Macro in the Code group of the Developer 
tab. 
• The Record Macro dialog box appears. 
2. Type a name for the macro in the Macro Name text box. 
• The first character of the macro name must be a letter, and 

the name cannot contain spaces or cell references. Macro 
names are not case-sensitive. 

3. (Optional) Assign a Shortcut Key. 
• If you select a shortcut key already used in Excel, the macro 

shortcut key overrides the Excel shortcut key while the 
workbook that contains the macro is open. 
 



Record a macro 
 

4. From the Store Macro In drop-down list, select 
where you want to store the macro: 
• This Workbook: Save the macro in the current 

workbook file. 
• New Workbook: Create macros that you can run 

in any new workbooks created during the current 
Excel session. 

• Personal Macro Workbook: Choose this option if 
you want the macro to be available whenever 
you use Excel, regardless of which worksheet 
you're using. 
 



Record a macro 
 

5. (Optional) Type a description of the macro in the 
Description text box. 
6. Click OK. 
7. Perform the actions you want to record. 
• The Record Macro option on the Developer tab 

changes to Stop Recording. 
8.Choose Stop Recording in the Code group of the 
Developer tab. 
• The macro recorder stops recording keystrokes 

and the macro is complete. 
 
 


